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1 | System Requirements 
 Windows 7, 8 or 10 
 2 GHz Processor, 2GB Ram 
 One open USB port 
 Actisys PC IrDA adapter 

• Windows 7 and 8 are supported by all IR Adapters. 
• Windows 10 is only supported with IR Adapters where the Serial Number prefix is "TA".   
 

2 | Obtaining the Link installer 
MSA Link can be obtained at: http://us.msasafety.com/productSoftwareDownloads  
 

3 | Installing the Actisys IR Adapter 
3.1 The device driver comes packaged with, and is installed during the installation 

3.2 In the event that this step is skipped: 
(A) Go to Control Panel (Change the view to small or large icons),  
(B) Choose “Device manager” and either under “Ports” or “Unknown Device” category, 

locate 

the device with the icon next to it (it may also reference TWN3 in the description) 
(C) Right-Click the device to open the action menu, and choose “Update Driver Software” 

For Windows 10 and required “TA” serial number prefix dongle:   
a) Choose “Search automatically for Updated driver software”  

For Windows 7/8:  
a) Choose “Browse my computer for driver software” 
b) Press the “Browse…” Button to navigate the file folders,  
c) Navigate to the folder where the MSA Link Installer was unzipped, and  
d) In its “dongle-drivers” folder, choose the correct folder for your version of 

Windows.  (The software with drivers can be re-downloaded from the “Product 
Software Downloads” page on msasafety.com if needed.) 

Once installed, “Prolific USB-to-Serial Comm Port” will appear in the “Ports” category 

 
 

  

http://us.msasafety.com/productSoftwareDownloads
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4 | Using the Actisys IR Adapter 
 

4.1 Enable the portable gas device’s IR.  (See device manual(s); procedure differs by model)  
Note: the ALTAIR 4X and 5X models are always enabled. 
 

4.2 Position the lens portion of the IR Adapter facing the infrared view port of the MSA gas detector. 
The devices should be approximately 2 inches apart. 

 

 
 

Note: Typically devices should be set face down to avoid possible misalignment due to belt clips 
located on the back of the devices. 
 

4.3 With the device now ready to use in Link, actions like: Connection Testing, Download, and Device 
Configuration, as described in the following sections, can be performed. 
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5 | The Connection Wizard 
5.1 The Connection Wizard provides a step 

by step way to verify your setup device 
connection. This option is set to run at 
application startup until it is disabled. 
 

 
 
 
 
 
 
 
 

5.2 Set preferences to download Session 
and/or Periodic Logs and if to 
synchronize the time and date during 
data downloads.   
 
To test the communications press the 
“Test Port” button. A notification will be 
presented indicating success or failure. 
 
 
 
 
 

5.3 At the end of the wizard, to avoid 
seeing it at application start, uncheck 
the checkbox “Show this dialog at 
startup.” 
 
Note: To access this Wizard again when 
unchecked, click “Options” on the 
menu and select “Connection Wizard”. 
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6 | Application Menu Icons 
 

  
1. Open 

2. Download Device Logs 

3. General Reports 

4. Periodic Reports 

5. Calibration Reports 

6. Instrument Configuration 

7. Real-time Readings 

 

7 | Setting Download Options 
 

7.1 During the first run, you will be prompted by the Connection Wizard to set these default values for 
device download sessions as described in Section 5.  
 

 
 

7.2 After initial setup, while you are running the program, the options can be accessed by going to the 
“Options” on the program menu, and selecting “Download Options”.  
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8 | Downloading Data 
8.1 With the device, its IR function on, and aligned with the IR adapter (as described in Section 4 

above)  Press the Link Download Icon to start the download: 
 

 
 
A progress indicator is displayed: 
 

  
 
When the Download is complete, the General Settings, and depending on the selected download 
options, Sensor Reading Charts, Calibration logs, Periodic Readings, and Session Events tabs are 
displayed: 
 

 
 

 

9 | Saving Downloaded Data 
Save the data in .msa session file format by opening the “File” menu and choosing “Save”. 
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The default saving directory will be the first folder opened, and the files can be saved here, or a new 
location can be browsed.  Saving the file with an extension other than the default *.msa will result in the 
application being unable to see the file and display it in the file browser. 

Session files (.msa format) can be accessed by Link, at a later time, for viewing, exporting, printing, 
archiving, or reporting.  

NOTE: if the instrument has a saved file already, save subsequent 
downloads by adding a new suffix as desired such as “-2”…”-3” or the 
current date, such as “01-01-2018”: 

File Security: To ensure security, the .msa data files are encrypted and digitally signed. This signing 
process ensures not only the integrity of the file, but protects against unwanted alteration of that file. Any 
decryption and subsequent alteration will result in the signing being invalid. MSA Link provides 
notification if the file has been corrupted or altered. 

 

10 | Working with Saved .MSA Files 
10.1 File Browser 

 
MSA Link's “Files” browser provides a 
convenient way to open sessions without 
the use of the operating system's file 
browser.  
 
Double-click a file to open it, or select the 
file desired, and right click on it and a pop 
up menu will open with available options 
Open, Delete, or Refresh the list. 

 
 

 

 

11 | Viewing, Printing, and Exporting Reports 
To view a session, an .MSA session file must be opened, or a new session has to be created by 
connecting to an instrument and downloading the data (Shown in the “Downloading Data” section). 

Inside that session view, are sub-tabs for the data reports available from the download: 

 
Clicking on them toggles the report in view. 
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11.1 Print, or Export to Excel, PDF or Word using the icons on the data download/session views: 

 

 
 

 
General 

These reports contain information about the model, serial, sensor, and alarm records. 
 
Periodic 

This report is a tabular list of all readings that have been taken by the instrument. Note that the 
instrument storage space is very limited and eventually “rolls” back on itself, overwriting the 
oldest records with the newest. So, eventually, a session will contain older event records than are 
available on the instrument. Also it is important to note that MMS Link does not function as a 
database and does not store historical records. This can be accomplished by simply saving older 
files, as they will have the historical data UNLESS that file is used as an active work session, 
subsequently updated, and then saved. 
 
Combined (Session) 

The Session Combined reports organize session, event, and periodic records into date structured 
slots. These slots are bookmarked along the side of the report for easy navigation throughout the 
report.  

The Combined report is partitioned into groups of data ordered by session. A session is defined 
as an ON/OFF power cycle. Note that some devices (ALTAIR) have neither power cycles nor 
periodic data. Within the session all the system events, periodic records, and session data are sub 
grouped. This can be accessed by using the expander icon (looks like a small +) to show the data. 
 
Calibration 

Calibration reports are made to print a calibration certification using the calibration information 
from the instrument. 

   
Sensor Charts 

The Sensor charts, in this example under the tabs   , can be screen captured for 
printing or insertion in a document. 
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12 | Setting/Changing the Default Data Directory 
Open the Options menu and choose  Preferences  Change Data Directory 
 

 
 

13 | Setting/Changing the Language 
 
Open the Options menu and choose  Preferences  Languages 
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14 | General Device Configuration 
With the device connected, as described above in Section 4, Click on the “Device” menu and choose 
“Configuration”.  The “Instrument Setup” dialog box will appear: 
 

 
 

14.1 Options Section 
Refer to the device user manual for specific details on each option's function.  
 
The General options available are: 
- Operating beep 
- Fresh Air Setup 
- 24 Hour time 
- Confidence LED 
- Show Peak Page 
- Show STEL Page 
- Show TWA Page 
 

14.2 Backlight Section 

Sets the time the backlight stays illuminated after device button activity. 
 

14.3 Label Section 

This section allows the entry of identification values on the device, which include “Department”, 
“Company”, and “Name” fields.  For ALTAIR 4 and later devices, these field values are limited to 10 
characters.  For ALTAIR devices before the ALTAIR 4, these field values are limited to 8 characters, 
and some models only have one ID field available.  These fields are empty by default.   
 
IMPORTANT NOTE:  
If your organization operates with rules concerning PII (Personally Identifiable Information), consult 
your compliance department before entering values in these “Label” fields. 
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14.4 Periodic Log Section 

The Interval setting determines the frequency of the periodic readings being recorded into the 
periodic data logs. 
 
It also has the option to set the periodic logs to be an average value over that interval, or a peak 
value. 
 

14.5 Language Section 

The device’s display Language can be set here. 
NOTE:  Some devices have limited language support. 
 

14.6 Calibration Due Section 

Set the days before calibration due is indicated.  
 

14.7 Bump Due Section 

Set the days before Bump due is indicated. 
 

14.8 Update Button 

The “Update” Button applies the options that are on the dialog page, to the connected device. 
 

14.9 Refresh Button 

The “Refresh” Button reads the current options that are set on the connected device, and loads 
them into the dialog page. 
 

14.10 Close Button 

Closes the “Instrument Setup” dialogue page. 
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15 | Advanced Device Configuration 
In addition to the configuration options referenced in the previous section, there are password protected 
settings.   

The configurations described in this section can be changed by MSA authorized personnel, distributors, 
service centers, and affiliates. If access is required to change alarm set points, please contact your MSA 
dealer or affiliate. 

The password is not included in this manual but MSA authorized personnel can obtain it from your MSA 
Sales Representative or MSA Customer Service. 

1. Ensure the device is on and connected as described in Section 4 above. 

2. Click on the “Password” menu, enter the password, and click the “OK” button: 
 

 
 

3. The box will disappear. 

4. Click on the “Password” menu again and the password protected settings will now be visible: 
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15.1 Alarm Settings 

  
The Alarm Settings screen will show the settings for the installed sensors, and the options for 
enabled/disabled, latching, and Visible, Audible, and Vibrating alarm types.   

STEL and TWA settings will appear only for appropriate sensors. 

The “Update Sensor” button writes the values set here to the device. 

The “Refresh” button reads the values set on the device currently. 

The “Read Defaults” button reads the factory default settings on the device, and can be used to then 
restore the factory settings by then pressing “Update Sensor”. 
 

15.2 Clear Log Options 

Session and Periodic records can be cleared from the instrument.  These permanently clear the data logs 
on the gas detector, and they cannot be recovered. 

 
 

This feature is useful if:  A) a record has become corrupt, or B) the unit is being transferred to another 
organization and it is desired to clear the data.  
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15.3 Check Instrument Password 

This utility allows the viewing of the device’s current password, and the ability to change the password 
using the ”Update” Button. 

 
 

15.4 Custom PID RF 

This utility allows the entry of custom RF values 

 
 

15.5 PID Favorites 

This utility allows the set up a list of favorite Gas Custom RF values on the device. 
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15.6 Calibration Gas 

Allows the setup of the calibration gas values used to calibrate. 

 
 

Preset Calibration Span Values: 

Standard Calibration cylinders settings are available through the list located at the bottom of the 
window, just above the buttons.  Double-click to populate the available gas channels on the main 
window. 

Custom Calibration Span Values:  

Custom Calibration cylinders settings can be set by typing the mixture values in the text boxes and 
selecting the option “Save Custom.” That Custom setup is now saved in the list and can be used Double-
clicked to populate the values above.  To delete custom setup levels, just select the entry from the list 
and press Delete on the keyboard. 

15.7 Protected Settings 

This utility controls the units associated with calibration gasses. 
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16 | Live Readings Chart 
A connected instrument can be used to generate live readings that are plotted on the screen in a rolling strip 
chart.  

1. Ensure the device is on and connected as described in Section 4 above. 

2. Open the “Chart” Menu and select “Realtime”  OR  press the Realtime icon   

Note: This option does not include data storage, so all data plotted in this method is “throw away” and used 
for visualization/experimentation only. 

Multiple sensors selected: 

 
Individual sensor selected: 
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17 | Serializing an Instrument 
On download, if MSA Link detects an instrument without a valid serial number (0). It will provide a 
prompt that will allow the serialization of the instrument.  

 
“Generate” makes a random serial number, to be applied.  

“Ok” sends the serial to the device.  

 

18 | Technical support 
For technical assistance installing or using this software 

Contact MSA at:  1-800-672-2222 or softwaresupport@msasafety.com  
 

  Please provide the following information with any request for assistance. 

1. MSA Link software version. (Help->About) 

2. MSA Instrument Firmware version. (Version information displayed at device startup) 

3. Microsoft Windows version. 

mailto:softwaresupport@msasafety.com
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